Spartan 6 Decoder Tutorial (Verilog) EE574/ECE3829

Nexys 3 board tutorial
(Decoder, ISE 14.1)
Jim Duckworth, August 2012, WPL

Note: you will need the Xilinx ISE Webpack installed on your computer (or you can use the
department systems).

[Note you can also review Xilinx Tutorials, for example, under Design Resources: ISE Design
Suite Tutorials, and ISE Design Suite Logic Edition - Quick Tour]

Start Xilinx ISE Design Suite,

Select File => New Project or click on New Project

and enter "decoder" for the project name (select an appropriate location):
- =)

&  New Project Wizard

Create New Project

Specify project location and type.
Enter a name, locations, and comment for the project
MName: decoder

Location: C:\ece3829\decoder

B E]

Working Directory: |C:\ece3329\decoder

Description: Decoder tutorial for Nexys3|Board

Select the type of top-evel source for the project

Top-evel source type:

HDL =]

) o)

Click Next and carefully select the family, device, package, etc to match the FPGA on the Nexys
3 board (also select ISim for the simulator):
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EES74/ECE3829

€/

Mew Project Wizard

Project Settings

Specify device and project properties.

Select the device and design flow for the project

Evaluation Development Beard Mone Specified | ~
Product Category All |
Family Spartanb -
1 Device X
Package C5G324 - I
Speed -3 -
Top-Level Source Type [HDL -
XST (WHDL/Verilog) || =
Simulator ISim (VHDL Verilog) -
Preferred Lanquage Verilog -
Property Specification in Project File | Store all values -
Manual Compile Crder
YHDL Source Analysis Standard |VHDL—93 -
Enable Message Filtering -
[ e | [ cone

Click Next, and then click Finish

View: @ {8 mplementation © ] simuiation
Hierarchy 2

B D oo

©-£1 xcbshd6-3csgi2d

Empty View

The view currently contains no fls. You ean add files to the
project using the toolbar at left, commands from the Project
menu, and by using the Design, Fies, and Libraries panels.

User
*New Source: To create a new source file,

*Add Source: To add an existing file to the project.

*Add Copy of Source: Ta copy an existing file to the
project directory and add it to the project.

T2 NoProcesses Running

No single design medule is selected,

e

Design Utiliies

NN

o Start | B3 Design | (] Fies | [} Libraries

Console

08 x

CJj |
[2] consoe Errors | 1\ Wamings | g4 Find in Flles Resuits
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Click on New Source (top left icon in the Design window), or menu option Project => New
Source.

Select Verilog Module, and type "decoder" for name:

Select Source Type

Select source type, file name and its location.

' IP (CORE Generator & Architecture Wizard)
[©] Schernatic

User Document

|| Verilog Medule

W] Verilog Test Fixture

g VHDL Module File name:
[y VHDL Library | r—
[F] VHDL Package
g VHDL Test Bench Location:

A Embedded Processor |C:\ece383\decoder | E

Add to project

Define Module

Specify ports for module,
Module name | decoder M
Port Mame Direction Bus MSB LSB =
W input =
| fled output o
input -
input -
input -
input

Click Next, and then Finish. A skeleton of your decoder Verilog source file is open for editing:
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ISE Project Navic oder. o, =18

2 Elle Edit View Project Source Process Tools Window Layout Help [BEE

DPHPIL[ s cbX[wa] [ 2288 "R =R 0=, FEL£]Q
Design 08 x| & 1 “timescale 1ns / 1ps

view: @ Jf Implementation () [ Simulation = N s

” " e 3 // Company:

Sty = 4 // Engineer:

} decoder = 5 //

B £ xcbshdb-3csg324 = € // Create Date: 11:29:42 08/19/2012

. [fd% decoder (decoderv) 7 // Design Name:
8 // Module Name: decoder

9 // Project Name:

10 // Target Devices:

11 // Tool versions:

12 // Description:

g

// Dependencies:

TS/

16 // Revision:

17 // Revision 0.01 - File Created

¥ Mo Processes Running

[©@|& ¥ ¥ |15

Processes: decoder

RIEIEE R AR

E  Design Summary/Reports 18 // Additional Comments:
Design Uilities 19 4/
User Constraints 20 SILIPEETELESITEEEEL T EEEETIE L L LI E PR R TR 8770 i i 88 E i i i i EEiiiiiiiiiisies
Synthesize - XST 21 module decoder(
€2 Implement Design 22 input [2:0] sw,
¥ Generate Programming File 23 cutput [7:0] led
@  Configure Target Device 24 )iz
“@*  Analyze Design Using ChipScope 25
26
27 endmodule
28
< . »
& Strt | &2 Design [ Fles [ Librares | @ decodery B[= Design Summary =]
Console +08x
|| 4 INFC:HDLCompiler:1845 - Analyzing Verilog file "C:/ece3829/decoder/decoder.v” into library work -

i) INFO:ProjectMgmt - Parsing design hierarchy completed successfully.

Started : "Launching ISE Text Editor to edit decoder.v".
Launching Design Summary/Report Viewer...

(] m r
Console ]_6 Errors | A\ Warnings [ lpg Find in Files Results

Ln1Coll

Verilag |

Add your name and a description to the header comments.

Add Verilog statements to describe the operation of the 3 to 8 decoder:

(729 ISE Text Editor (P.15x7) - [decuder;’J_ o

File Edit View Window Layout Help [=[=] %]
R = Rl
= 18 // Additionmal Comments: -
= S
p— 20 SSASIEAAPEEEETEEEIEE SRR R i ii il i i i i ridifidiifrdfiddifiriifddfiriifriris,
= 21 module decoder(
ey 22 input [2:0] =w,
. 23 cutput [7:0] led

24 )z
2 25
= 26 assign led = (sw == 3'b000) ? 8'b00000001
A 27 (sw =— 3'b001) ? 8'b0O000O0O1OD :
% 28 (gw == 3'b010) ? 8'b00000100

29 (sw == 3'b011) ? 8'b00001000
* 30 (gw == 3'b100) ? 8'b00010000
% 31 {sw == 3'bl01) ? 8'b00100000 L
b 32 (sw =— 3'bl110) ? 8'b01000000 1
@ 2 8'b10000000;
@ Sy
—_— 35 endmodule

36

L] 1 b

decoder.v® B8 |

Lnl Coll Verilog
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EES74/ECE3829

In the Processes window (middle-left window of ISE Project Navigator) — double-click on

Synthesize to verify your design.

If successful you should see a green check mark next to the Synthesize operation:

- _
o ISE Project Navigator 120\d =&

File Edit View Project Source Process Tools Window Layout Help EEE

DRAEFIL[ 4 DEXx|va| o, pR2RINmE s p L9

Design had =l XI 4 S/ / =
lI [0 | View: @ ﬁl}lmplememaﬁon ) [ simulation ; 16 // Revision:
| B —_ 17 // Revision 0.01 - File Created

&l Hlerarchy 18 // Additional Comments:

% > decoder I /

o E‘EE xchishd6-3csg324 20 SSSSSSSESESES ST SEET P ET i i AP fifiiriiriiritirisrid

frey 3:5:2 decoder (decoderv) 21 module decoder|
lg = 22 input [2:0] sw,

o = 23 cutput [7:0] led (3

¥ A 24 ¥

% 25

P | €2 Mo Processes Running 26 assign led = (sw == 3'b000) ? 8'b0O000000L :

% T — = e 27 (sw == 3'b001) ? 8'b00000010 : 1

] : =i 3¢ 28 (sw == 3'b010) ? 8'b00000100 : =
Al = PesignSummary/Reports —| =29 (sw == 3'b011) ? &'b00001000 :
| w Design Utilities (€] 30 (sw == 3'b100) ? 8'b00010000 :
|7 : User Constraints =2 e 31 (sw == 3'b101) ? 8'b00100000 :

— | = 8@ Synthesize - XST —| 32 (sw == 3'b110) ? £'b01000000 :

€2  Implement Design 33 £'b10000000; ==

Generate Programming File 8 34
Configure Target Device e e T ik
J __ o Chi o - ] | F

| Design Summary (Synthesized)

decoder.v

Analvze D
=

|D Libraries

B =1

Console

Minimum period: No path found

Minimum input arrival time before clock: Ho path found
Maximum output required time after clock: No path found
Maximum combinational path delay: 5.607ns

Process "Synthesize - XST" completed successfully

4 m | +

Console |_T° Errors |JB Warnings |!ﬁ Find in Files Results

Lnl Coll Verilog

=

Note: in the Console window note that 1 RAM is inferred.
Note: If any syntax errors are listed then fix these in your decoder.v source file.

We now need to assign FPGA pins to the switches and leds so they will be connected to the
correct ports on the board. This is done by creating a UCF file (User Constraints File).

Expand the User Constraints process in the Processes window and double-click on the I/O Pin
Planning (Plan Ahead) - Post Synthesis.

Plan Ahead will start and alert you to create a UCF file:

Copyright © 2012 R James Duckworth Rev A
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W] ISE Project Navigator ﬁ

This process requires that an Implementation Constraint File (UCF) be added to
the project and associated with the selected design module. Would you like
Project Mavigator to automatically create a UCF and add it to the project at this
time?

If you select "Mo” you will need to create or add an existing UCF to the project
before running this process.

ves || Mo

Select Yes

PlanAhead will now run, eventually a window will open (select the I/O ports tab and then
expand the led and sw ports.

Select led[0] in the I/O ports window and drag to the package pin location U16:
The Site box in the I/O Port Properties window should be updated (instead of dragging, you can
also type the site location directly).

-
E decoder - [C\ece574\nexys3\decoder\planAhead_run_2\decoder.ppr] - PlanAhead 13.2
File Edit Tools Window Layout View Help
B X &5 G QO K| @ [Buoramn -] % oo W % K
Netlist Design - decoder_ucf (target) *
Netlist - 0Oa x
= =
=
- (i) Mram_led21 -
- [ Mram_led31
[ Mram_led41 |2 |
(i) Mram_led51 |
[ Mram_leds1
=
£ Sources, () Netlist | £ Timing Constraints (UCF) |
Site Properties -0 g x
+« > Ek
[E uis
acHTian [ U |y
2 Properties
IjO Ports. — 0O g %
[‘{. Mame Dir Neg Di \ Site Bank [/OStd Veco  Wref  Drive Strength  Slew Type  Pull Type  Off-Chip Termination  IN_TERM  OUT_TERM
Z B All ports (11) -
=] E-g led (8)  Output 2 L\I'CMOSZS 2 5 12 SLOW FP_VTT_50 NONE MNONE i
=
& -0 led[1] Output 12 SLOW P _VTT_S| NONE MONE
?\] (:l led[2] Output LVCMOSZS 2‘5 12 sLow FP_\"'I'I'_SD NONE MNONE
<1 led[3] Output LVCMOS25 2.5 12 sLow FP_VTT_50 NONE NONE
(:l led[4] Output LVCMOS25 2.5 12 sLow FP_VTT_50 NONE NONE £
<1 led[5] Output LVCMOS25 25 12 sSLOwW FP_VTT_50 NONE MNONE
(:l led[5] Output LVCMOS25 2.5 12 sLow FP_VTT_50 NONE NONE
47 led[7] Output LVCMOS25 25 12 sLOwW FP_VTT_50 NONE NONE
=% sw(3) Input LVCMOS25 12 sLow NONE NONE MNONE
O swl0] Input LVCMOS25 12 sLow NONE NONE NONE =
O sw[1] Input LVCMOS25 12 sLow NONE NONE MNONE -
Dr sw[2] Input LVCMOS25 12 sLow MONE NONE MNONE =]
Package Pins - 0o =
C\ Mame Prohibit Port IfOStd  Dir Veco  Bank  BankType  BUFIO2Region  Type DiffPair  Clock  Voltage  Config  System Mo
= =
Za| E-me 1O Bank 2 (Stand 56) 25 Standard -
= - §3 R15 D 25tandard  BR Multi-function L1P B
E!; D Ti5 2 Standard BR Multi-function L 1N
Ui -ml---—_—----
ﬁ) V16 2 Standard BR Multi-function L2N
< . | * E‘
5 Td Console | " Messages-. O Package Pins
ISE Integration Flovw
A
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With reference to the Nexys3 Reference Manual complete the pin information for the rest of the
led and sw ports.

Select File => Save Design and exit PlanAhead.
In the ISE Project Navigator Design - Hierarchy window expand the decoder and you should see

the new decoder.ucf file is now added. To view the UCEF file, select the decoder.ucf and then
select Edit Constraints (Text) in the Processes window and the decoder.ucf file will open:

il |
ISE Text Editor (0.61xd) - [decoder.ucf] EE
Eile Edit View Window Layout Help - |

=H IS
1= 1
b= 2 # Planhhead Generated phyvsical constcraints
f— 3
4 HET "led[0]"™ LOC = Ul&;
5 5 HET "led[l]"™ LOC = V1&;
g HET "led[2]" LOC = Ul5;
7 HET "led[3]" LOC = V15;
o g8 HET "led[4]"™ LOC = M11;
—_— g HET "led[S]"™ LOC = NH11;
A 10 HET "led[&]™ LOC = R11;
o 11 HET "led[7]"™ LOC = T11;
. 12 HET "=zw[O]"™ LOC = T10;
A 13 HNET "s=sw[l]" LOC = T9;
g1 14 HET "sw[2]" LOC = V9;
e ~
¥ |4 r
decoder.ucf x| |
LnlColl UCF
L

Note: You can also just create and edit this UCF file using a text editor (like Notepad or
wordpad).

We can now complete the Synthesis, Implementation, and Generate Programming File steps.

When we generate a programming file we need to specify the FPGA Startup Clock. This will be
set to JTAG for when we load the FPGA through the USB connector using the Adept
Programming Software. When we generate a PROM (FLASH) file then the startup clock should
be set to CCLK.

To set the start-up clock, right-click on the Generate Programming File in the Processes window
and then select Process Properties.
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Select the Startup Options in the Category window and change to JTAG (for loading via USB):

N\

r !
Erg Process Properties - Startup Options \ ﬂ
N
i Switch Name Property Name \ Value
G g StartUpClk: | FPGA Start Up Clock ITAG Clock (~]
. Configuration Options

Wtartup Options -g DonePiper  Enable Internal Done Pipe (=]

-~ Readback Options -g DONE_cycle:| Done (Qutput Events) Default (4) |E|

) EDE?;T;;;V:LTS;;D”S -g GTS cycler | Enable Outputs (Output Events) Default (5) |z|

-g GWE_cycle: | Release Write Enable (Output Events) Default (6) |z|

-g LCK_cycler | Wait for DCM and PLL Lock (Qutput Events) | Default (NoWait) |Z|
-g DriveDone: | Drive Done Pin High ()

Property display level: |Advanced |z| Display switch names

o) (o ) oo ] [ ]

Back in the design window select the decoder-Behavioral (decoder.vhd) and then double-click
on the Generate Programming File process.

You should eventually see a "Generate Programming File" message in the console window and
green check marks against Synthesis, Implementation, and Generate Programming File
processes:

o 15E Project Navigator (Q.61xd) - C\eceS74\nexys3\decoder\decoder.xise - [decoder.vhd] I
File Edit View Project Source Process Jools Window Layout Help
DAEF L nbX|wal |22 2R 2802 lepEliQ
Design «+0a XI 4 30 --use UNISIM.VComponents.all: o
) | view: @ @}Imp{emenbton Simulation b 31
9 Hi h - 32 entity decoder is
& R, 33 Port ( sw : in SID LOGIC_VECTOR (2 downta Q)
& decoder - 34 led : out STD LOGIC VECTCR (7 downta 0)):
— | B £3 xcbshd6-2csg324 35 end decoder;
o = 5% decoder - Behavioral (decodervhd) 36
= E decodernucf a2 37 architecture Behavioral of decoder is
& =
¥ A 39 begin
% 40
# | B2 Mo Processes Running 41 led <= 01" when sw = "000" else
== % g
l?f‘ Processes: decoder - Behavioral e 22 wfjen sige
= % 43 when else
24 | = Design Utilities = 44 when Elae
o User Constraints @ 45 when else
Erﬁ Create Timing Constraints 'D 45 when elze
= b I/0 Pin Planning (PlanAhead) - Pre-Synthesis it 47 when elae A
i /O Pin Planning (PlanAhead) - Post-Synthesis 5 48 : 3
1 Floorplan Area/10/Logic (PlanAhead) 3 49
Synthesize - 5T 50 end Behavioral;
Implement Design 51
) Generate Programming File 52
Configure Target Device B £
Analyze Design Using ChipScope % 4 [l s
& Start | B} Design |[|"_"| Files E Libraries | £ Design Summary (Programming File Generated) || _ decodervhd [ ‘ decoderucf ||

Console +0OF X

Started : "Generate Programming File".
Running bitgen...
Command Line: bitgen -intstyle ise -f decoder.ut decoder.ncd

Process "Generate Programming File™ completed successfully

1

1

1 |
Console F-o Errors |_Q Warnings |rﬁ Find in Files Results
Ln4l Col42 VHDL
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Select the Design Summary Properties tab in the emain window and you can view the FPGA
device utilization and other results:

S —
Design Summary (Programming Fle Generated)]
% Fle Edit View Project Source Process Jools Window Layout Hel
DPEHF L snoxwel Jrrpp @ zancfieree]Q
= T z
Design =S 7Y - Design %:‘r’z’;’y decoder Project Status (08/27 /2011 - 19:32:43) 1=
[f [vew: @ 1} Implementatior i Smuiation 6 [ 108 Properties Project File: decoder.xise Parser Errors: No Errors
il fcnrchy, [2 Module Level Utiization Hodule Name: decoder ion State: Fie Generated
@l ] decoder 5] [2 Timing Constraints = = T E No B
- £ xcBshdb-2csg324 o [2 Pinout Report mrgcticvios i g s lo Errors
2 - [l decoder - Behavioral (decodervhd) B Clock Report Product Version: ISE 13.2 *Warnings: No Warnings I
= * [ decoderuct = @ static Timing Design Goak Balanced +Routing Results: Al Signals Completely Routed
& Errors and Warnings - — =
i\ D) Parser Messages Design Strategy: Xilinx Default furlocked) «Timing Constraints: E
8 o4 [2) Synthesis Messages Environment: System Settings *Final Timing Score: 0 (Timing Report)
P hoil [ Translation Messages
= [2 Map Messages
T [ Place and Route Messages T =]
2 Timing Messages
[ Bitgen Messages Slice Logic Utilization used Available utilization Hote(s)
[2) Alllmplementation Messages Number of Slice Registers 0 18,224 0%
- Detailed Reports |
No Pr Ry
B | B2 NoProcesses Running B Symhess Rt Number of Sice LUTs 4 5,112 1%
| Processes: decoder - Behavioral [£) Translation Report P ioed 2 lonkc b &112 i
2| E  Design Summary/Reports 2] Map Report Number using O cutput only 0
Sl Design Utiities [2 Place and Route Report = prey g
: iumber using O output only
Bl g e o [2) Post-PAR Static Timing Report
= "8 Create Timing Constraints [) Power Report MNumber using 05 and 06 4
- L /0 Pin Planning (PlanAhead) - Pre-Synthesis s @d B'@RE” Rff“’t Number used 2s ROM 0
§ T econdary Reports
1/0 Pin Planning (PlanAhead) - Post-Synthesis i e P R T = e =
] Fioorplan Area/10/Logic (PlanAhead)
Synthesize - XST —— Number of occupied Sices 3 2,278 1%,
esign Properties
Implement Design "] Enable Message Filtering umber of LUT Flp Flop pars used 4+
Een;vate Prgf:tr%mms File Optional Design Summary Contents Number with an unused Fip Flop Gl 4 ]
onfigure Target Device ] Show Clock Report
Analyze Design Using ChipScope s o € Number with an unused LUT 0 1 0%
-] Show Warnings Number of fully used LUTFF pairs 0 4 0%
[0 Show Errors Mumber of siice register sites lost 0 18,224 0%
to control set restrictions
Number of bonded 10Bs 11 232 4%
\ Number of LOCed I0Bs 11 11 100%
Number of RAMB 16BWERs 0 32 0%
Number of RAMBBBWERS 0 64 0% i
& Start | @3 Design | L Fies | [ Librares | [= Design Summary (Programming Fie Generated) [x] decodenvhd (=]
Console: +0O &5 X
Running bitgen...
Command Line: bitgea -intstyle ise -f decoder.ut decoder.ned
Process "Generate Programming File" completed successfully
Started : "Launching ISE Text Editor to edit decoder.vhd".
L1 P—r— 3
Console | @) Errors | 1} Warnings |28 Findin Fies Results

Some of this information and also from the corresponding Design Overview files will be requried
for your project reports.

You can now close the ISE Project Navigator.
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Loading the FPGA

The next step is to transfer the FPGA bit file through the USB cable using the Digilent Adept
software (download from the Digilent website and install).

Connect your Nexys2/3 board to a USB connector on the PC.

Click on the Adept software and the Adept software should recognize the board and show the
FPGA device:

I Connect; [Nexy53 - ]
NEXYS 3 Product: MNexys3

Config  Memory | Test | Register I/0 | File I/0 | I/O Ex | Settings |

FPGA Progra
’ v] Browse... Program

Initialize Chain

Loading board information. .. a
Initizlizing Scan Chain. ..
Board information loaded.
Found device ID: 34002093
Initialization Complete.
Device 1: XCA5LX 16

[

1

L = —

(Select Initalize Chain if you do not see the FPGA device)
On the FPGA line select Browse and select the decoder.bit file from your project directory
Then select Program.

After programming the DONE led should light on your board and your design should start
running!
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You can also load a bit file into the SPI or BPI Flash devices (remember to change the startup
clock to CCLK):

T
Connect: [Nexyss
NEXYS 3 Product: Mexys3
Config | Memory | Test | Register IfO | File 70 | 10 Ex | Settings |

FPGA programming file to Flash

|

[Browse... ] [ Program ] (C) SPIFlash

(@ BPI Flash
Make sure that the BIT programming file has Start-Up Clock set to CCLK |:| Verify 2
and for BPI the MCS data width is set to 16.

Read Memory content to File Full Test

[Browse... ] [ Read ]

Erase

Start address: 0 Length: 100000 hex

e

Config Reset

Write File to Memory

[Browse... ] [ Write ]

Cancel

Start address: 0 hex = [T verify

Loading board information. .. - l

Initializing Scan Chain.. .

Board information loaded. |

Found device ID: 34002093

Initialization Complete. |
Device 1: XC65LX 16 [

« g
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